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This User Guide provides information about LinksPoint’s
SymbolPlus validated Serial GPS receiver for mobile
computers from Symbol Technologies.

The LinksPoint Serial GPS receiver collects GPS satellite
data and provides it to the mobile computer through the serial
port of a Symbol vehicle docking cradle. GPS information is
available to the handheld computer when docked. Two versions are available. One is
powered by an external 12V cigarette lighter adaptor and can be used with all MC900XX
and MC70 vehicle cradles. The second version can be used with MC70 cradle versions
that output power through the serial connector.

There are two versions of LinksPoint’s Serial GPS receiver:

m LP11631- For use with all MC90XX and MC70 vehicle cradles. This version is
powered by a 12V DC “cigarette lighter” adaptor.

m LP11632 — For use with MC70 vehicle cradle with power out through the serial
connector. This version is powered through the DB9 serial connector used to connect
the receiver to the cradle’s serial port. In this configuration, the GPS is powered only
when the mobile computer is docked in the cradle and a valid GPS com port is open
in a running GPS application.

The LinksPoint Serial GPS receiver has been tested for compatibility with the following
operating systems:

= Windows® Mobile 2003 — MC90XX
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m Windows® Mobile 2003 Phone Edition — MC90XX

m Windows® Mobile 5.0 — MC90XX and MC70

m Windows® Mobile 5.0 Phone Edition — MC90XX and MC70(Pending)
m Windows® CE 5.0 — MC90XX

The LinksPoint Serial GPS receiver outputs GPS information as industry standard NMEA
sentences which are compatible with most GPS software applications. It can also be
configured to output GPS information in the SiRF Binary format.

LinksPoint's GPS receivers offer typical accuracies of 3-5 meters uncorrected, and 3
meters or better with Wide Area Augmentation System (WAAS) correction. 1 They are
tested to comply with FCC and CE standards.

Sy mbol .|.PLUS SymbolPlus product validation is reserved for "best in class"
vaLipaTep peripherals that have been tested for quality, reliability,

service and system interoperability with Symbol mobile computers. The LinksPoint serial
GPS receiver for Symbol mobile computers has been tested under Symboal's guidelines to
ensure compliance with the SymbolPlus program.

For detailed information on the Symbol MC90XX or MC70 mobile computer, see the
Quick Reference Guide or Product Reference Guide for the mobile computer, available at
www.symbol.com/manuals.

Note: Screens and windows pictured in this User Guide are samples and may vary.

Connecting the LinksPoint Serial GPS Receiver External Power

Version (LinksPoint Part Number LP11631) to Symbol Vehicle Cradles

The LinksPoint Serial GPS Receiver with cigarette lighter power adaptor (LinksPoint Part
Number LP11631) can be used with MC90XX S (Short) and K (Brick) and MC70 vehicle
cradles. Set up instructions are the same for all of these. In this installation, the GPS
receiver draws power from a 12V DC “cigarette lighter” adaptor. As long as the adaptor is
powered, the GPS receiver will operate. As such, the DC power jack needs to draw
uninterrupted power from the vehicle for constant operation of the GPS receiver. Install the
vehicle cradle before connecting the LinksPoint Serial GPS Receiver.

For detailed information on Symbol MC90XX vehicle cradles, see the Quick Reference
Guide or Product Reference Guide for the vehicles cradles, available at
www.symbol.com/manuals.

When attached to the vehicle dock, the Serial GPS receiver allows the mobile computer,
when docked in the cradle, to capture GPS data.

*Accuracy is subject to degradation based on environmental and positional conditions. Rated accuracy provides 95%
Circle Error Probability (CEP) position accuracies of <5 meters with WAAS correction and <10 meters uncorrected.
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Step 1

To connect the Serial GPS to the vehicle cradle, plug the DB9 Serial connector into the
serial port found on the bottom of the cradle to the left of the power cable. Tighten the DB9
serial connector with the thumbscrews to ensure a secure connection.

Step 2

Connect the longer of the two PS2 style connecters coming from the DB9 Serial connector
to the PS2 connector coming from the GPS receiver.
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Step 3

Connect the shorter of the two PS2 style connecters coming from the DB9 Serial
connector to the PS2 connector coming from the DC power adaptor. The DC power
adaptor should them be plugged into the vehicle’s DC power jack.

Step 4

Position the GPS receiver where it has a clear view of the sky for optimal performance.
The receiver is magnetized for use with vehicle roofs.
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Connecting the LinksPoint Serial GPS Receiver Serial Powered

Version (LinksPoint Part Number LP11632) to Symbol Vehicle Cradles

The serial powered version of the LinksPoint Serial GPS Receiver (LP11632) certain
versions of the MC70 vehicle cradle that offer power out through the DB9 serial connector.
Consult Symbol documentation to determine if you have a compatible cradle. In this
configuration, the GPS receiver draws power from the MC70 mobile computer through the
DB9 serial connector and requires no additional power supply. As a result, the GPS is
powered only when the mobile computer is docked in the cradle and a valid GPS com port
is open in a running GPS application. If the mobile computer is undocked or goes into
suspend mode, power is no longer supplied to the GPS receiver. This situation may lead
to slightly longer GPS start times when the mobile computer is docked or is resumed after
a suspend. Install the vehicle cradle before connecting the LinksPoint Serial GPS
Receiver.

For detailed information on Symbol MC70 vehicle cradles, see the Quick Reference Guide
or Product Reference Guide for the vehicles cradles, available at
www.symbol.com/manuals.

When attached to the vehicle dock, the Serial GPS receiver allows the mobile computer,
when docked in the cradle, to capture GPS data.

Step 1
To connect the Serial GPS to the vehicle cradle, plug the DB9 Serial connector into the

serial port found on the bottom of the cradle to the left of the power cable. Tighten the DB9
serial connector with the thumbscrews to ensure a secure connection.
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Step 2

Connect PS2 style connecter coming from the DB9 Serial connector to the PS2 connector
coming from the GPS receiver.

Step 3

Position the GPS receiver where it has a clear view of the sky for optimal performance.
The receiver is magnetized for use with vehicle roofs.
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Getting Started

Using the Serial GPS receiver with an existing GPS application

The Serial GPS receiver is designed to work “out-of-the-box” with GPS applications that
accept data in the NMEA protocol format.

The National Marine Electronics Association regulates the NMEA 0183 specifications
standard which defines a set of ASCIl strings, called sentences, which relay GPS
navigation information. This is the most commonly used standard for GPS
communications.

To configure the Serial GPS receiver for use with a GPS application that supports the
NMEA protocal, set the following parameters in the GPS application:

m GPS Com Port or Com Port: COM1
m Baud Rate: 4800

m Protocol: NMEA (Depending on the GPS application, you may not be asked to enter
the protocol.)

Once these parameters have been set, the GPS application should begin automatically
receiving GPS data from the Serial GPS receiver. Please consult the GPS application
documentation for further information on how to communicate with an attached GPS
receiver.

Using the Serial GPS receiver with the GlobalPoint GPS application

The GlobalPoint GPS application provides a means to confirm proper operation of the
Serial GPS receiver and configure the mode of operation (NMEA or SiRF). Detailed
instructions on how to use the GlobalPoint GPS application are included below.

The GlobalPoint GPS application can be downloaded at www.linkspoint.com/Serial GPS
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GlobalPoint GPS Software

The GlobalPoint GPS software provides a means to configure and confirm operation of
the Serial GPS receiver. In the GlobalPoint GPS software you will be able to choose the
mode of operation of the receiver and display positioning and performance information.

GlobalPoint GPS software can be downloaded at www.linkspoint.com/hardware.asp.

Tools Menu Options

Use the Tools menu to access configuration options or to exit the program.

GlobalPoint GPS

Parameter | Walue

1¢6:32 €3

Units

Latitude  41.07822
Longitude  -73.51268

UTC 23:32:47
Quaality Mormal
HOOP 16

Speed 0.14
Heading 155.7
Sats Used 5
Pratocol NMEL

Degrees
Degrees
Time

MPH
Degrees True

Reset Receiver

Configure...

Change Receiver Protocol...

Exit

Tools| Yiew E| | I El-

The tools menu contains the following options:

m Reset Receiver

m Change Receiver Protocol

m Configure

m Exit

Important Note: When first using the GlobalPoint GPS application, go to the Configure...
option first to set up communication between the Serial GPS Receiver and Symbol mobile

computer.

LINKSPOINT USER GUIDE LINKSPOINT SERIAL GPS §0R SYMBOL






Reset Receiver

Use the Reset Receiver option to select the Start Mode and begin a new initialization of
the receiver.

GlobalPaint GPS {631 €

(@ Cold Start
(") Hot Start

I OK | |Eantel|

B~

Cold Start causes the receiver to release any fix information and completely re-initialize
navigation data (almanac, ephemeris, and clock). Typical “Time to First Fix” (TTFF) is 45
seconds or less.

Hot Start causes the receiver to keep existing navigation data and refresh the fix. Typical
TTFF is 8 seconds or less.
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Change Receiver Protocol

Change Receiver Protocol causes the receiver to switch between the two available
modes of operation: NMEA or SiRF. NMEA is the default mode of operation for the Serial
GPS Receiver for the Symbol mobile computers.

When in NMEA mode, choose this option to switch to SiRF mode.

GlobalPoint GPS < 6:34

Pararneter | Value Units

Latitude 41.07833  Degrees
Longitude -73.51273 Degrees

& GlobalPoint 101

& Switching To SIRF (35400)

0K Cancel

Uncarrected 30 point solution

Tools 'n'iew E ‘ [ | s El‘

The GlobalPoint GPS application requires the user to confirm switching the mode of
operation from NMEA to SiRF. To cancel the Change Receiver Protocol command, tap
on “Cancel.”
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When in SiRF mode, choose this option to switch to NMEA mode.

GlobalPoint GPS <635 (D

Please select from the folowing
MME& message aptions;

GGEA
[ ]GLL
G5y
G354,

RIMC
[]wTa

| OK | | Cancel |

El;

The GlobalPoint GPS application requires the user to confirm switching the mode of
operation from SiRF to NMEA. To cancel the Change Receiver Protocol command, tap
on “Cancel.”

The Change Receiver Protocol also allows the user to choose which NMEA sentences
are to be communicated from the Serial GPS receiver to the mobie computer. The
following NMEA sentences are supported by the Serial GPS receiver:

GSV - Set this NMEA sentence to the update interval for the GNSS Satellites in view.

GLL - Set this NMEA sentence to the update interval for the Geographic Position: Latitude
and Longitude.

RMC - Set this NMEA sentence to the update interval for the Recommended Minimum
Specific GNSS Data.

GSA - Set this NMEA sentence to the update interval for the GNSS DOP and Active
Satellites.

VTG - Set this NMEA sentence to the update interval for the Course Over Ground and
Ground Speed.

The default NMEA sentences for the Serial GPS receiver are GGA, GSV, GSA and RMC.
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Configure

Use this option to configure the connection between the Serial GPS receiver and the
Symbol mobile computer.

GlobalPoint GPS < 6:37 (D

Com Port;  |[COML: -|
Baud Rate: (4800 |
-Protocol

{_) SRF (W NMEL,

Auto Detect

OK I | Cancel |

=]~

Com Port

This value determines the PC communications port the GPS receiver is connected to. The
default for the Serial GPS receiver is: COM1.

Baud Rate

This value determines the Baud Rate (or data transfer rate) at which the GPS receiver
communicates with the mobile computer. The default for the Serial GPS is: 4800.

Protocol

This value determines the mode of operation to be used by the Serial GPS receiver. The
default for the Serial GPS receiver is: NMEA.

Auto Detect

Use this option to have the GlobalPoint GPS application automatically detect the Com
Port, Baud Rate and Protocol in use by the GPS receiver attached to the mobile
computer.

OK and Cancel

Select “OK” to save the settings selected or “Cancel” to disregard any changes.
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Exit

Use the Exit option to quit the GlobalPoint GPS application return to the Windows Mobile
“Today” screen.

Important Note: To fully exit the GlobalPoint GPS application, the Exit option must be
used. “Closing” the application by tapping on the “X” in the upper-right-hand portion of the
screen will not exit the program, but cause it to be minimized where it will continue running
in memory. If the GlobalPoint GPS application is running in memory, it will block other
GPS applications from running properly on the mobile computer.

View Options
Use the View menu to choose how tracking information is displayed within the GlobalPoint
GPS application.
GlobalPoint GPS <6:38 €3
Parameter | Value Units

Latitude 41.07811  Degrees
Longitude -73.51203 Degrees

UTC 23:38:02 Time

Quality Morral

HOoOP 28.7

Speed 1.24 MPH

Heading 313.0 Degrees True
Sats Used 4

Protocol MMES,

Navigation
Satellites
Uncor| Raw Data olution

Tools h‘iew E ‘ [ | P El‘

The tools menu contains the following options:
m Navigation

m Satellites

m Raw Data

These options can also be selected by tapping on the following icons:

Navigation

[ue]
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E Raw Data

Fix Description

At the lower portion of the screen, just above the Tools menu, the GlobalPoint GPS

application displays the type of fix currently acquired by the GPS receiver. This value can

change over time as the receiver’s viewable sky changes, or if the receiver is re-initialized.
The types of fixes are:

m Invalid unavailable solution — This signifies that not enough satellite data is available
to provide a fix. This occurs as the receiver is initialized or when an insufficient
number of satellites are in the viewable sky.

m Corrected 3D point solution — This signifies that a three-dimensional GPS fix is
available and that it is corrected using WAAS.

m Uncorrected 3D point solution - This signifies that a standard three-dimensional GPS
fix is available.

m Uncorrected 2D point solution — This signifies that a two-dimensional GPS fix is
acquired.

Navigation View

Use the “Navigation” view to display summary data for GPS fix information communicated
from the GPS receiver.

GlobalPaint GPS {¢6:30 €3

Pararneter | Value Units

Latitude 41.07833 Degrees
Longitude -73.51272 Degrees

UTC 23:30:14 Time

Quality Mormnal

HOOP 16

Speed 0.21 MPH

Heading 155.7 Deqgress True
Sats Used 9

Protocol MMES,

Uncarrected 30 point solution

Tools h'iew E ‘ iz El“

Parameters displayed in the Navigation view are:

m Latitude — Displays the current location on the face of the Earth north or south of the
Equator. Latitude is an angular measurement ranging from 0°at the Equator to 90°at
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the poles (90° N or 90° S). In the GlobalPoint GPS application, North is shown as a
positive value and South is show as a negative value.

m Longitude — Displays the current location on the face of the Earth east or west of a
north-south line called the Prime Meridian. Longitude is an angular measurement
ranging from 0°at the Prime Meridian to +180°east ward and —180°westward. In the
GlobalPoint GPS application, East is shown as a positive value and West is show as
a negative value.

m UTC - “Coordinated Universal Time or UTC,” is the equivalent of Greenwich Mean
Time, the astronomical basis for civil time.

m Quality — Displays whether current fix is a “Normal” uncorrected fix or a WAAS
“Corrected” fix.

m HDOP - “Horizontal Dilution Of Precision” is a measure of how the satellite geometry
influences the latitude and longitude data accuracy. A good satellite geometry and
hence a good accuracy is obtained if the satellites being tracked are located as far
away from each other as possible, while the geometry is poor if the satellites are
located close to each other. If the HDOP value is higher than about 10 the latitude and
longitude data likely to be inaccurate.

m Speed — Displays the current velocity in miles per hour.

m Heading — Displays the current direction of travel in degrees with North being 0°

m Sats Used — The number of satellites used in the current fix.

m Protocol — The current mode of operation. This can be SiRF or NMEA.
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Satellites View

Use the “Satellite” view to display summary data about the available satellites in the
viewable sky.

GlobalPoint GPS d:6:59 €3

Satelite SNR
4 31

7 49
24 47

2 2
20 35
28 o

S 0

23 1]

Uncarrected 30 point solution

Tools Yiew E ‘ nmz El‘

Parameters displayed in the Navigation view are:

m Satellites — This column displays all satellites available in the viewable sky by the
identifying number of each satellite as determined by the GPS authorities.

m SNR - This value indicates the carrier signal to noise ratio for the signal received by
the individual satellite. Typically, satellites with SNR values below 28 are not used in
GPS fixes.

m Satellite Sky Map — This graphic image displays the relative position of the viewable
satellites overhead.
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Raw Data View

Use the “Raw Data” view to display raw GPS signal data being received by the GPS
receiver.

GlobalPoint GPS d<7:01 €3

$GPGGA,000056,609,4104, 7061, M,073=) &
$GPGSA,A,2,07,24,,,,,,,,,,0.0,0.0,0.0*3[ |
$GPRMZ,000056.609,4,4104.7061,M,07.
P

$GPRMC,000057.609,4,4104,7061,M,07

$GPGGA,000058.609,4104,. 7061,N,0732
$GPGSA,A,2,07,24,,,,,,,,,0.0,0.0,0.0%3
$GPRMC,000058.609,4,4104.7061, 1,07,
P

$GPGSV,2,1,08,04,75,285,26,07,73,07¢
$GPGSV,2,2,08,20,25,047,,28,21, 163,
$GPRMC,000059.600,4,4104,7061,M,07 |

$GPRMC,000100.609,4,4104.7061,N,07 %
O

4| in | [ »
Uncarrected 2D point solution

Tools Yiew ‘ nmz El‘

Additional Options

«|

Pause

Tapping the “Pause” icon temporarily pauses the GPS data stream being received by the
GPS receiver. To resume the GPS data stream, tap on the pause icon. When active, the
pause icon will have a gray background. When paused, the icon will have a white
background.

Pause Icon (unpaused)

Pause Icon (paused)
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Specifications

Supported Operating Systems

m Windows® Mobile 2003

m Windows® Mobile 2003 Phone Edition

m Windows® Mobile 5.0

m Windows® Mobile 5.0 Phone Edition (Pending)

Chipset
GPS Chipset:  SiRFstar lll
Chipset Processor:  ARM7/TDMI — 49MHZ
Receiver
Frequency: L1, CA code
Signal Acquisition: 1920 time/frequency search channels
Channels: 20 Channels; all-in-view tracking
Max. Update Rate: 10Hz
Sensitivity: ~ -159dBW
DGPS Source:  Default: None
DGPS Programmable: WAAS/EGNOS
System Back Up:  Built-in Lithium-lon rechargeable battery
Antenna Type: Built-in Antenna (external antenna optional)
Position/Time Accuracy (without SA)
Autonomous: <10m
WAAS  <5m
Velocity: 0.1 meters/second
Time: 1 microsecond synchronized to GPS time
Datum:  WGS-84
Acquisition Rate

Reacquisition:  100msec
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Hot Start: <1 second
Warm Start: <38 seconds
Cold Start: <42 sec
Protocol
Default: ~ NMEA-0183 (V2.20)- GGA(1), GSA(1), GSV(5), RMC(1)
Programmable:  Additional NMEA- VTG, GLL / SiRF Binary
Power
Draw:  70mA at 3.3V; DC power adaptor
Internal Battery:  3v (for GPS module only)
Dynamic Conditions
Altitude: <18,000 meter
Velocity: < 515 meter/second
Acceleration:  <4g
Environmental
Water Seal:  Waterproof to 1 meter
Operating Temperature: -20C to +60C
Storage Temperature: -40CT to 70C
Humidity:  N/A
Regulatory
Marks:  FCC, CE, RoHS
Physical Interface to Vehicle Cradle

Connector: DB9 with cigarette lighter power adaptor; DB9 with power
on Pin9.

Dimensions

Depth:  62.0mm

Width: 46.1mm
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Height:  18.0mm
Weight: 959
Part Numbers

For MC90XX/MC70: LP11631 (with Cig. Lighter Adaptor)

For MC70 with powered serial connector: LP11632 (with Pin9 serial power cable)

Regulatory Information

Radio Frequency Interference Requirements

NOTE: This equipment has been tested and found to
comply with the limits for a Class B digital device.
FC ﬁf e,fctg gt’;”nﬂzrds pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against
FOR HOME OR OFFICEUSE | harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encourages to try to correct the interference by one or

more of the following measures:

* Reorient or relocate the receiving antenna
* Increase the separation between the equipment and receiver

« Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected

« Consult the dealer or an experienced radio/TV technician for help

CAUTION: Changes or modifications to this equipment not expressly approved by the
party responsible for compliance could void the user’s authority to operate the equipment.

CE Marking and The European Economic Area (EEA)

Links Point, Inc., hereby, declares that this device is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC. A

Declaration of Conformity may be obtained from http:/www.linkspoint.com/ce doc.asp
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(a) LinksPoint’s hardware Products are warranted against defects in workmanship and materials for a period of twelve (12) months
from the date of shipment by LinksPoint's reseller to its customer, but in no event more than fifteen (15) months from shipment of the
Products by LinksPoint, unless otherwise provided by LinksPoint in writing, provided the Product remains unmodified and is
operated under normal and proper conditions. Warranty provisions and durations on software, integrated installed systems, Product
modified or designed to meet specific customer specifications (“Custom products”), remanufactured products, and reconditioned or
upgraded products, shall be as provided in the applicable Product specification in effect at the time of purchase or in the
accompanying software license; (b) Spare parts (i.e. Parts, components, or subassemblies sold by LinksPoaint for use in the service
and maintenance of Products) are warranted against defects in workmanship and materials for a period of thirty (30) days from the
date of shipment. Spare parts may be new or originate from returned units under the conditions set forth in subsection (d) below; (c)
For repairs on LinksPoint-branded hardware Products under this Agreement, including repairs covered by warranty, the repair
services provided are warranted against defects in workmanship and materials on the repaired component of the Product for a
period of thirty (30) days from the shipment date of the repaired Product, or until the end of the original warranty period, whichever is
longer; and (d) Products may be serviced or manufactured with parts, components, or subassemblies that originate from returned
products and that have been tested as meeting applicable specifications for equivalent new material and Products. The sole
obligation of LinksPoint for defective hardware Products is limited to repair or replacement (at LinksPoint’s option) on a “return to
service depot’ basis with prior LinksPoint authorization. Solution Provider is responsible for shipment to LinksPoint and assumes all
costs and risks associated with this transportation; return shipment to the Solution Provider will be at LinksPoint's expense. Solution
Provider shall be responsible for return shipment charges for product returned where LinksPoint determines there is no defect (‘No
Defect Found”), or for Product returned that LinksPoint determines is not eligible for warranty repair. No charge will be made to
Solution Provider for replacement parts for warranty repairs. LinksPoint is not responsible for any damage to or loss of any software
programs, data or removable data storage media, or the restoration or reinstallaion of any software programs or data other than the
software, if any, installed by LinksPoint during the manufacture of the Product; (e) Except for the warranty applying solely to the
repaired component arising from a repair service as provided in (c) above, the aforementioned provisions do not extend the original
warranty period of any Product that had either been repaired or replaced by LinksPoint; (f) The above warranty shall not apply to any
Product (I) which has been repaired, tampered with, altered or modified, except by LinksPoint's authorized service personnel; or (11)
in which the defects or damage to the Product result from normal wear and tear, misuse, negligence, improper storage, water or
other liquids, battery leakage, use of parts or accessories not approved or supplied by LinksPoint, or failure to perform operator
handling and scheduled maintenance instructions supplied by LinksPoint; (Ill) which has been subjected to unusual physical or
electrical stress, abuse, or accident, or forces or exposure beyond normal use within the specified operational and environmental
parameters set forth in the applicable Product specification; nor shall the above warranty provisions apply to any expendable or
consumable items, such as batteries, supplied with Product. EXCEPT FOR THE WARRANTY OF TITLE AND THE EXPRESS
WARRANTIES STATED ABOVE, LINKSPOINT DISCLAIMS ALL WARRANTIES ON PRODUCTS FURNISHED HEREUNDER
INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR USE. ANY IMPLIED
WARRANTIES THAT MAY BE IMPOSED BY LAW ARE LIMITED IN DURATION TO THE LIMITED WARRANTY PERIOD.
SOME STATES OR COUNTRIES DO NOT ALLOW A LIMITATION ON HOW LONG AN IMPLIED WARRANTY LASTS OR THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR CONSUMER PRODUCTS. IN SUCH
STATES OR COUNTRIES, FOR SUCH PRODUCTS, SOME EXCLUSIONS OR LIMITATIONS OF THIS LIMITED WARRANTY
MAY NOT APPLY. The stated express warranties are in lieu of all obligations or liabiliies on the part of LinksPoint for damages,
including but not limited to, special, indirect or consequential damages arising out of or in connection with the use or performance of
the Product or service. LinksPoint’s liability for damages to Solution Provider or others resulting from the use of any Product or
service furnished here under shall in no way exceed the purchase price of said Product or the fair market value of said service,
except in instances of injury to persons or property.

To the fullest extent allowed by law, the warranties and remedies set forth in this agreement are exclusive and in lieu of all other
warranties terms or conditions, express or implied, either in fact or by operation of law, statutory or otherwise, including without
limitaion warranties terms or conditions of/as to satisfactory quality, merchantability, fitness for a particular purpose, conformance to
contract, correspondence with description and non-infingement, all of which are expressly excluded. LinksPoint's warranties herein
are granted only to Distributor, and are not extended to any third parties that, for the avoidance of doubt, include any resellers,
agents or dealers of Distributor.

LinksPoint neither assumes nor authorizes any other person to assume for it any other liability in connection with the sale,
installation, maintenance or use of its products, and LinksPoint provides no warranty whatsoever for any non-standard Products
supplied by it hereunder.

LINKSPOINT SHALL NOT BE LIABLE UNDER THIS WARRANTY IF TS TESTING AND EXAMINATION DISCLOSE THAT THE
ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST ORWAS CAUSED BY DISTRIBUTOR'S, OR DISTRIBUTOR'S
RESELLER, OR END USER'S, OR ANY THIRD PERSON'S MISUSE, NEGLIGENCE, IMPROPER INSTALLATION OR
TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE INSTALLATION OR TESTING,
UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, ORBY
ACCIDENT, FIRE, LIGHTNING OR OTHER HAZARD.

LINKSPOINT USER GUIDE LINKSPOINT SERIAL GPSZ®R SYMBOL






Service Information

Before you use the Serial GPS receiver, it must be configured to operate with our mobile
computer and applications.

If you have a problem using the Serial GPS receiver, contact your facility’s Technical or
Systems Support. If there is a problem with the equipment, they will contact the LinksPoint
Support Center:

Email: support@linkspoint.com

Telephone: +1203.853.4600 Ext. 4

For the latest version of this guide go to hitp:/www.linkspoint.com/GPSMC9000

Original Release - September 2006

LinksPoint
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